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From the login page, you can use your email to register an account that is
recommended, as you will be able to save results and upload your own data.
Otherwise just use guest account to view public data.
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1. Overview of CHOmics

There are several panels stacked in the main interface. The recent experiment and projects are listed in
the panel separately for quick access. You can also access them and other functions from the shortcuts
at the top menu bar.

% CHOmics vt |‘<--no" - Y . |
Welcome to BxGenomics \[ Shortcuts to data tables ]

&2 My Experiments and Analyses

& My Private Projects

B Al Comparisons REE

= List of Comparisons O shoe

Show/hide left menu

1.1 Menu Bar

In top menu bar, several shortcuts are listed for quick access of functions including: Toolbox, My
Analysis, and Admin, Projects, Comparisons and Samples.

‘Toolbox’ contains a list of functional modules including: ‘Import Project Data’,’Gene Expression
Analysis’, ‘Comparison-based Analysis’, ‘Pathway Visualization’ and ‘Other tools’.

‘My Analysis’ provides quick access to the information of all ‘Experiments’, ‘Samples’ and ‘Analysis’.

‘Admin’ allows the users to manage the data files from private folder, shared folder and overview the
platforms applied to all data sets.

‘Projects’, ‘Comparisons’ and ‘Samples’ all provide searching function and access to specific project,
comparison and sample respectively.

1.2 Experiments and Analyses

Experiment is designed for running the built-in RNA sequencing pipeline on the raw sequencing data.
Once the experiment is created, users can upload raw fastq files and sample meta information, and then
launch the built-in pipeline for analysis. After the analysis is completed, the analysis report is generated
and the results can be exported as one ‘Project’ for visualization and cross-project comparison.

4 CHOmICS tva)  Tootbox ™ v . s

Welcome to BxGenomics

Create Experiment for analysis ]
k2 My Experiments and Analyses

Add sample and run

- Vi NG it TP it n P04 analysis

Sample list in analysis

v . v

Analysis report ]
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1.3 Projects

The project is used to perform data mining and data visualization. Users can either import analysis
report from ‘Experiment’ or upload pre-processed data to create a project. In the project, users can
easily explore different features of the data (e.g, Gene expression profiling, sample clustering, PCA,
differential expression genes and pathways, etc), compare the analysis with the other projects or
perform the meta-analysis by combining multiple projects.

M CHOMICS (V1) Tockoex ™ & - . o ool 95

Welcome to BxGenomics

2 My Experiments and Analyses . e
Y i [ Create Project ] 2

& My Private Projects - a

Sample and comparison list

Each project mainly consists of samples including both meta information and omics profiling, and
comparisons showing the statistical differences among samples.

1.4 Samples
A project may include many samples which can be searched by the ‘Sample’ in top menu bar. Each
sample has its own properties including Species, CellType, DiseaseState,etc (details available by clicking

the *= button on the left ends).

& CHOmics (v1) Toolbox™ MyAnalyses~ Admin~ Projects (2)  Comps 5) Heilo, Demo User @ Sign Out

Q Advanced Search 1% Change Column Settings @ Create Sample List >+‘

Fleld to Search Operator Value

Check/Uncheck All

| P | [ Detailed view of sample ] oty

D B Nm/mw- P SamplingTime Treatment

= 1 rumexo:os Transcriptomics D108

SeceeP & DK1B2D108 Transcriptomics D108
= 3 DK1B3D108 Transcriptomics D108
= 4 DK1B4D108 Transcriptomics D108
= v 5 DK1B1D72 Transcriptomics D72
= 6 DK1B2D72 Transcriptomics D72
= 7 DK1B3D72 Transcriptomics D72
= 8 DK1B1D84 Transcriptomics D84
= 2 DiK1B2D84 Transcriptomics D84

Page | 5



To change columns displayed in the table, using the table settings (green button). Users can also select
the samples to save them into the sample list. Samples from the list can be loaded to other analysis or
visualization stools like heatmap.

Each sample has a gene expression profile. In CHOmics, there are multiple ways to analyze and visualize
the samples including: correlation tool (noted by ‘C’), gene expression plot( noted by ‘E’), expression
heatmap (noted by ‘H’), and PCA analysis (noted by ‘P’).

4 CHOmics (v)) Toolbox~ MyAnalyses~ Admin~ Projects(2) Comparisons (16) Samples (56) Hello, Demo User @ Sign Out

Sample DK181D108

» Seal

.
Tools for sample analysis

Found in project CHO De

Found in comparisons: [

Gene Expression Correlation Gene Expression Plot Gene Expression Heatmap PCA Analysis

D 1 ProjectsID 1
Project Name  CHO Demo - CHO Demo RNA-Seq Analysis PlatformsiD 2
Platform  NGS_Mouse PlatfoomType NGS
PlatformName  Generic Mouse NGS Platform SamplesiD 27
Species Mouse Name DKiBiD108
Description  CHO sampie DK1-B1-D108, Time D108, Replicate Bx Sampleindex 27
CellType DiseaseCategory
DiseaseState Ethnicity
Gender Infection
Organism Response
SamplePathology SampleSource  Transcriptomics

1.5 Comparisons
Comparison is defined by the comparative analysis between two groups of samples including differential
gene analysis and pathway enrichment analysis.

There are a lot of meta data available for each comparison. See the dashboard for an overview of key
categories, and the detailed description of each comparison has the full information.
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4 CHOmics (v) Toolbox~™ MyAnalyses~> Admin~ Projects(2) Comparisons (16) Samples (56) Hello. Demo User  (# Sign Out
Seal'Ch Search Comparison Display Comparison Save to comparison list Save to sample list
Note’ You can do quick st —_ —_—
Q Advanced Search 9% Change Column Settings B Create Comparison List iam;mw » Rpset search conditions
Check/Uncheck All
’ Sk Search |
Column visibilit Copy csv . . . |
e, Detailed view of comparison ]

D e Case SamplelDs Control SampleiDs
EEPMHEECVWVR K a | D84vsD72 Show/Hide Show/Hide
EEAMHEONMYVW AKX 2 Dgbvs D72 Show/Hide Show/Hide

EaMREeVYW RK 3 D108vs D72 Show/Hide Show/Hide
=B M RBREeVvWwRK 4 Dgbvs D84 Show/Hide Show/Hide
= 8 MK eV W R K B D108vs D84 Show/Hide Show/Hide
S B MOV wNRK @ D108vs Dg6 Show/Hide Show/Hide

The selected comparisons can be saved to the comparison list (yellow button) for easy loading into the

plotting tools.

Several options on each comparison for complicated visualization and analysis are also listed including:
bubble plot of gene expressions(noted by ‘B’), meta analysis (noted by ‘M’), pathway heamap plot(noted
by ‘H’), significant changes genes (noted by ‘C’), volcano plot(noted by ‘V’), Wikipathway mapping(noted

by ‘W’), and Rectome and KEGG pathway mapping (noted by ‘R’ and ‘K’ respectively).

% CHOmics (v1) Toolbox¥ My Analyses~ Admin~ Projects(2) Comparisons 16) Samples (56) Hello. DemoUser @ Sign Out
comparison: D84.vs.D72
» Search All Comparisons  » View Comparison Genes » Edit Comparison Details
Options for comparison
D Name Project Category  DiseaseState analysis and visualization Control Samples

CHO Demo - CHO Demo RNA-Seq Analysis Show/Hide Show/H

1 D84vsD72 Unknown Dcsease/w
——

» Download SVG File

Up Regulated Genes

Biological Process

Cellular Component
olecular Functio
KEGG
ecular Signatu

Biological Process

RNA processing|

metabolic process|

organic substance metabolic process|
ribonucieoprotein compiex blogenesis|
primary metabolic process
macromolecule metabolic process|
nitrogen compound metabolic process
ribosome biogenesis

cellular metabolic process|

NCRNA proccssmg- tog(p)-35.26
o 200 400 600

Number of Genes

Page | 7



1.6 Genes

The genome-wide gene expression values were detected in each sample using RNA-Seq or microarrays.
All the human genes that have expression values are listed in gene table. The gene annotation from
difference platforms were all mapped to NCBI gene ID (EntrezID) for consistence across platforms.

M CHOmICs 1) ot

Search

To find a gene, you can use gene symbol, gene description, gene alias, NCBI gene ID, Ensembl gene ID
or Uniprot ID.

For some common genes, the symbols used in publications are often not the official symbol, and you
can try search alias field. For example, TP53 is often referred to as P53 in publication. You need to
search P53 in alias or tumor protein p53 in description to find it if you don't know its official symbol.

The NCBI Gene search https://www.ncbi.nlm.nih.gov/gene is a good source to get official gene symbols
and IDs.

You can view full details of a gene by clicking the *= button .
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cene GM1895

» Search All Genes

View expression plot

G Gene Expression Plot  8) Gene Bubble Plot

Genelndex
EntreziD

Description

10000003
10000003
100418032
predicted gene. 18956

ENSMUSG

View Bubble plot across

Uniprot

Start

ExonLength

AccNum

NA

3252757

480

NA

Biotype

Mouse

Gm18gs56

Ensembl_mouse_gene_vg4

Gm18956

NA

1

1

3253236

Gm18gs6

processed_pseudogene

From gene details, you can access RNA-Seq data in a box plot, or view all comparisons including this

gene in a bubble plot.

2 Data Input

2.1 Upload fastq files to experiment

After the experiment is created, users can upload fastq or fastq.gz files through remote URLs, server files
or local files. The files are uploaded to the private folder named ‘Experiments’ automatically.
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£ CHOmiCS (v))  Toolbax ™ My Analises = Admin Projects () Comparisons (10} - Semples (58 Moo, Domo Usee 69 Sipn Out

Experiment Test xcoiete Exx
Manager files in folder
Valid data files in current experiment: 0

[
M

&3

Drag & Drop a File

l0ct an option below

EN .~ EA
Remaote URLs. Seever Files

Experiment Details @ix
Time Croatod: 2019-10-13

Description Test

Experiment Samples o

Experiment Analyses

In the folder ‘Experiments’, there may be multiple subfolders corresponding to different experiments.
Users can easily modify the folder or upload new files to the folder.

4 CHOmiCS (V1) Moo Demo User @ Sign Ot

(o o o SRR & e [ 2 e
Actiors

Extomal Link (Share among applications)

@x

Experiment folder n

7 %

Upload files to the folder

Subfolders

2.2 Upload data file to project

Besides raw RNA sequencing data (fastq files), CHOmics also allow the input of other types of data to
start a project, including meta data (i.e,project and samples), expression data, and summary data. Those
data should be uploaded in comma separated values (CSV) or tab separated values (TSV) with either
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fixed or flexible format.

4 CHOmics (v1) oo — - g m 0 ' oo User B Sigr
Import proj i
; Import data to project

3 >

“lexible Formats
[ Import data file with flexible format ]

Tips for Impot

“ixed Formats

Project File (eg

Nama. Platform (GEO

Project file can be uploaded to create a new project. The project file contains some required information
such as Name, Platform and other optional fields such as Disease, Description etc.

Sample file can be uploaded to register samples for a project. The sample file contains required
information such as Name and Project_ Name and optional fields such as Description, Tissue,
DiseaseState, SampleSource, Gender, etc.

Expression file can be uploaded with quantified expression measure at gene level. The expression could
be transcriptomics, proteomics or other gene-level counts. The file is required to contain GeneName,
SampleName, Value.

Comparison file and Comparison data file are used to upload summary results for statistical comparison

test applied externally. Comparison file needs to contain the Project_ Name, Case_SamplelDs, and
Control_SamplelDs while comparison data file contains statistical results such as GeneName,
ComparisonName, Log2FoldChange, PValue, Adjusted PValue for each comparison.

4 CHOmics (vl)  Toolbax ™ My A v Admin~ £ mphird 15 Derno Use o S
Import Project Data

o ‘ »

Projects | Choose File o e chosen
Samples: | Choose File )
Comparisons  Choose File

[pample Expeossion Data: ~ Choose File o flo che

Comparison Datx  Choose Fito

Import different data files Example file format
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3 Data Analysis

3.1 RNAseq analysis pipeline

After fastq files are uploaded to the experiment by following the Section 2.1, users can start the analysis
by applying the built-in pipeline mainly including: Raw Data QC (quality control), Alignment, Gene
Counts and QC, and DEG, GSEA and GO analysis. After the analysis is completed, the results can be

exported into a project for visualization.

% CHOmMICS (v1)  Toolbax™ My Analysos = Admin ™ Project

anatyss CHO Demo RNA-Seq Analysis x

Analysis Details o

Analysis Samples uatype so

16 sampios aro used. & = °

Analysis Steps and Progress

B Finsize Anaiysis [ Analysis pipeline for RNAseq

2"

Status
Bv
Bv
Bv
av

Report files

Step Files

EE R K

After completion of each step, a report is generated for summarizing the metrics in each step to
quantify raw data QC, alignment with Subread method, and gene count distribution and sample/gene

count QC, respectively.

In the report for raw data QC, all fastq files are verified in quality by software fastQC. Sequencing read
information and quality control metrics are summarized for each individual fastq file.

A CHOmics (v1)  Teolbax~ My

BxGenomics - Raw Sequencing Data QC

Sample fastq file

Read information ]
Total Sequoences Tagood as POor  Sequence #Total Decuplicated
Sequences  quality tength NGC  Percentage

32221085 °

47835535

25000801
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QC metrics

Filio Name
WARN
WAR WA
WARE
WA
WARN WARN
W WA

In the report for alignment, parameter setting and quality metrics (e.g, mapped, junctions,etc) for

alignment are listed for each fastq file.

@ CHOmics (v1) Toolbox™ My Analyses = A

Subread: v150-p1 (hit

BxGenomics - Sequence Alignment Logs

Subjunc Settings

Function :
Threads :
Input file :
Output file :
Index name :
Phred offset :

Min votes :
Allowed mismatch :
Max indels :

# of Best mapping :
Unique mapping :
Hamming distance :
Quality scores :

Summary:

Processed :
Mapped :
Junctions :
Indels :

Running time :

Read alignment + Junction detection (RNA-Seq)

6

/raid/\ampp/htdocs/chomics/app_data/analysis/2_yr ...
/raid/\ampp/htdocs/chomics/app_data/analysis/2_yr ...
/var/www/html/cho_genomics/app_data/files_core/PI ...
33

1714
3 bases
5
1
no
no
no

27636352 reads
26781244 reads (96.9%)
111928

46043

12.6 minutes

In the report for Gene Counts and QC step, several metrics have been calculated and plotted for

comprehensive evaluation of genes and samples, including: reads mapping to genes, distribution of
detected genes, percentage of reads for highly expressed genes, normalization and boxplot of gene
expression, sample grouping and clustering, sample correlation and outlier detection.

‘1. Assign reads to genes’ plots the mapping summary of reads to genes, showing the percentage of
reads assigned to genes or unassigned due to unmapping, no features or ambiguous mapping.

Page | 13



M CHOmICS (V1)  Toolbox ™ My Anatysss > Admin ™ - Projects () Comparisons 6l Samples 5] In-Fage Navigation * Holio, Domo User @ Sign Out

BxGenomics - RNA-Seq QC Report

1 Assign Reads to Genes

The alignment bam files were compared aganst the gene annotation GFF fle. and raw counts for each gene were generated using the featureCounts tool from
subread. The graph below shows mapping and gene assignment summary. Click the graph to download the pdf version You can also download the csv file that

contans the numbers

* Downlcad the raw gene counts in CSV format. This fite Usts the number of reads mapped to each gene.

Mapping Summary
; @ Unassgnes Usmagoed
@ Unassgred NoFeatures
@ Unassignes Ambiguty
:i o Assgred
X
g
; 3
38
g 2
§<
s r E- I - -1
2§§§§§§§§§§§:§§
§ 85585 3gEE%gEEEg&%
It s normal some number of reads samples. However, samples with extremety low number of reads may not be sultable for
downstream analysis, and we recommend checking the additonal C metrics below to identify ! 7 Ly

‘2. Number of Genes Detected’ plots the number of expressed genes with read count from intervals
of >=1, >=2, >=10, >=50 and >=100.

‘3. Percentage Reads from Most Highly Expressed Genes’ plots the percentage of reads mapped to the
top expressed genes (up to 100 genes).
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2. Number of Genes Detected

Next, we performed additional QC at gene level. We first looked at number of genes detected. We count the number of genes that have at least 1. 2. 10, 50 or 100
counts. In generally. number of genes with 2 or more counts can be used as a rough estimate of how many genes are expressed. Genes with only 1 read could be
noise. In addition, the number of genes with 10 or more reads is a good indicator of how many genes have enough reads for downstream statistical analysis. Click
the graph to download a pdf version, you can also download a csv file containing the numbers,

Number of Expressed Genes

Read Count’
§<->.|oo
2 | = 50

| >«10

B >.2
gum
el

L 3BEEIBEILiECEE
S&aagisdgdsggai
SRR EEEE R EEEEEE

We also try to detect outliers from this step. Any samples that show very small number of genes with 10 or more reads are potential outliers. The cutoff we used
is 1/2 of the median across all samples.

3. Percentage Reads from Most Highly Expressed Genes

We also look at the percentage of reads belonging to the top genes. Basically we rank the
genes by read counts, and compute the percentage of reads belonging to the top genes
(up to top 100).

If majority of the reads come from top genes. then the sample probably has bottlenecking ) 57355 72 -7 T4 s ma®m smaanm
issues where a few genes were amplified many times by PCR during library preparation. o o o o
Most samples should have ~ 20% reads mapped to the top 100 genes.

If the top 100 genes account for more than 35% of all reads, we consider this sample as a
potential outlier. . .
Click the graph to download a pdf version. You can also download a csv file download the RSP - A LRSS Rt /bl
csv file that contains the numbers.

Iremn-

‘4. Normalization and Boxplot of Gene Expression’ evaluates gene expression after normalization by
TMM method and then draws boxplot of normalized expression (logCPM: log of counts per million
reads) after log2 transformation.
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4. Normalization and Boxplot of Gene Expression

The raw counts data were further processed by the following steps:

a) Remove genes that were not expressed. If a gene has counts per million (CPM) value >=1 in at least two of the samples, we consider it expressed in the
experiment and include it for downstream QC analysis. From 32871 total genes, 14212 genes are selected as expressed and used in downstream QC analysis.

b) The TMM normalization method was used to scale samples to remove

differences in the composition of the RNA population between samples. It is Name group
performed with the edgeR package. The normalization factors for all samples
are listed below. You can download the csv file. DK1B1D108 1

At this step, we also try to identity outliers that have extreme normalization

factors (>1.5 or <0.66). Note sometimes samples with large biological DKiB1D72 +
differences can have extreme normalization factors.
DK1B1D84 1
DK1B1Dg6 1

lib.size

23619476
41669151
21522805

24476888

norm.factors

0927

1010

1028

0.995

¢) The normalized gene counts were transformed to log2 scale using voom method from the R Limma package. We created boxplot for each sample to

summarize gene expression.

Since this is normalized data. most samples should look similar. Samples with high or low distribution may be outliers (or have large biological differences).

Normalized Expression Values (logCPM from voom)

15
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o 00
oo
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—m
-
e
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3 ) 8
° o ©
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[+]

B 8. 8. 8. % 8. % % ¥, % & B .0 & p
2 N 3 28 N 3 223N 382 3 8
S - 53 S 88 8888%8¢833
& c g8 ccgd g3
x 4 x 4
QQQQQQQQQQQﬁQQQ

‘5 Grouping and Clustering of Samples’ plots the relationship among samples by multidimensional scale.

Samples are clustered by hierarchical clustering method based on the expression of top genes with large

variation(SD/mean>0.3).
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5. Grouping and Clustering of Samples

a) We first create multidimensional plot to view sample relationships. This is
done using R Limma package.

Here biological replicates should cluster together, and difference conditions

D108
ideally should separate from each other. oxia818
-« DK183D108
=]
o~ N
E -© DK1B1D96
°
2 DK1B2D84
B ok18B53E108
g o DK1B2072
§ DK1B4D108
“ DK1B3D72
< 7| oxigiaeoes
DK1B4D96
>
S DK1B4D84 DK1B1D72

T T T T T T T

04 02 00 02 04 06 08

Leading logFC dim 1

b) Very often hierarchical clustering can give better indication of the sample Color Key
and gene relationships. We used made4 package from R to cluster samples
and draw a heatmap.

We selected genes that have variable expression across samples to make the
heatmap. These variable genes were chosen based on standard deviation (SD)
of expression values larger than 30% of the mean expression values (Mean). If
there are more than >5000 variable genes, we first remove genes with mean
logCPM«<1, then rank genes by SD/Mean to get the top 5000 genes.

The heatmap is created from 1124 variable genes.

In the heatmap above, we selected genes that changed across samples
(normally by SD/mean > 0.3), and plotted the relatively gene expression levels
(blue is low, red is high). Gene names are not shown due to large number of
genes used to create the heatmap. Both genes and samples are clustered in
the heatmap. Normally biological replicates should cluster together, and
ideally there should be up- or down- regulated genes between different
conditions.

Heatmap can be used to detect overall patterns. as well as outlier samples.

|

= E———
TR EEONN2IZEAEEE
§3523c88525823§8
$XEEKXKEEzZgEKEKE

‘6 Sample correlation’ creates scatter plots for the correlation between sample pairs. The idea is that
biological replicates from the same group should look similar in the scatter plot, and should have high
correlation values compared to the samples from other groups.
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6. Sample correlation

We also created scatter plots for the correlation between sample pairs. If there are many samples, you may need to download the graph and view it at full size
Again, the idea here is that biological replicates should look similar in the scatter plot, and should have high correlation values.

DK1B1D108

&

- N . 090 10987 0987 0902 0989 0991 052 099
|
2 > X om - 0906 « 0993 =099 - 0992 0984 Sk 0993
|/ / / oK1B1Ds | | 0 001 pu 001 ~om o001 o <001
i
: ‘ / / / / / S | |

/ / / / / / o] et l
NN A== == ===
/ / / / / / / / ocwonn| 238 || 2 (| s || zm || o | s |
‘/ / / / / / / / / | el | s

avavaviraviravaravi=aE
VDDAV DV VIRE
A7 77 A ==
Vira7aVira"a"a"a"a"a"a Vi EE

VAV D

3.2 DE, GSEA and GO analysis

After completing the first three steps for sample quality control and gene count readout, users can start

statistical analysis as the last step of pipeline, including differential expression analysis (DEG), gene set
enrichment analysis (GSEA) and gene ontology (GO) analysis.

DEG analysis is applied to compare gene expression between two groups, namely comparison. Users can
design one or multiple comparisons for DEG analysis. In each comparison, differential expressed genes
are identified by LIMMA model, followed by GSEA pathway analysis and GO enrichment analysis which
explore the enrichment of DEGs in diverse pathways.
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Analysis Details o

Analysis Samples  ws 1ype

Sl e nect @ P : °

Analysis Steps and Progress

[$5coe e R e

Suna Stap Fhos

oo Parameter for gene set analysis ]
o 06
DEG Parameters
v a [ Design comparison for DEG analysis ]
- =9 /
. .

The reports for DEG and pathway analysis are attached for each comparison after completion of
analysis.
MCHOMICS vl Toobou s .

s TESE x

Analysis Details

Analysis Samples

Analysis Steps and Progress

[0 0cicn e ST 4 i e

av
oV
(%
BV

P s P [ Report for DEG, GSEA and GO analysis ]

In the report for DEG analysis, the table summarizing DEGs with up- and down-regulation is listed along
with a heatmap clustering the DEGs expression (up to top 1000 DEGs).
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Differentially Expressed Genes for D108vs.D72

1 Summary of Differentially Expressed Genes (DEGs) |\L
Tor comoraon The e O GReraty erend gene DG e Town Seiow Up- Spn adinn bl doen
1094783 Qi 20 NG 1 70 9400 OGN
cuor S e ok a3 FOR 008 DEGs summary table

¥ o Up-seguistind ioes

YOU Py Wit 10 vere G-y st
0 UNERINQEd ¥ou £an View SUEh hadt

In the report for GO enrichment analysis, barplots show the significance of enrichment of up- or down-
regulated DEGs in different pathway databases, e.g, GO, KEGG, Wiki pathways, etc.

MCHOMICSIVI) Tooon™ MyAvoivins ™ Anwe™ Fowm @ Covpanomatll Sempios 1o s 0eme U WSO

Gene Ontology Enrichment Analysis Results

Pathway analysis for up-regulated DEGs ]

Biological Process

Introduction

TAS D08 ALY 16 10 10 818 0 ALACEOnS, derenment of dfeentia

Up Aegulated Genes iRt |

Down Rogulatod Ganes

Biological Process

Nember of Ganes

Similarly, in the report for GSEA analysis, enrichment results for up- and down- regulated DEGs in
pathways from MigDB database are plotted with significance level (FDR), respectively.
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BxGenomics - Summary of GSEA Analysis

Introduction
TV D3ge Ha0kays e 109 30 E5tS 0 AUKTON. envchment of Gfrential exnessed genes
2 GSEA Topt0 Ganes Summary Deta for A Como
D108vSD72  wves Deatad epon
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Negative Enrichment Positive Ennichment

3.3 Saved Genes and Comparisons

Customers can save selected genes or comparison for future use (e.g. multiple gene and multiple
comparisons bubble plot). From gene search, check the genes you want to save, and click the yellow
button "save selected genes

M CHOmicS (vl) Toolbax~> MyAnstyses > Admin~ Projects (1) Comparisons (12) - Samples (3ol Hoflo, Domo User 8 Sign Out
Search e .
Note You can do quic na the e

Check/Uncheck All

[ 1. Search Term g

comnvanaty | | copy | [-cov. ] Spow (3903 eniries Search. [gluta
n *  GeneName EntreziD Source Alias
E N0 nooos glutamate 57 NA NA
8 = @ 6 (ooen 53 NA NA
=m0 S 2. Check genes of interests N
= 0o nooen NA
E 80 noowm N-acetylgiutamine 33943 NA NA
E @ oo glutamate_gamma- 3487 NA NA
mathyloster
= 8 6 oo pyroglutamine 46225 NA NA
E 8 0 ooy N-acetyl-aspartyl- 35665 NA NA
glutamate NAAG
You can do the same with comparisons.
4 CHOmics (v1)  Toolbox MyAnatyses™ Admin~ Projcts(t) Comparsons i2) Sampias (30) Hotlo. Domo User @ Sign Out

Search  comparson

can do quick 5o using tho search box on the top-right of the table, or apply advanced soarch below

Q Advanced Search a #t | BCese » Reset search conditions
[ 1. Search Term 'I:

Check/Uncheck All
commvuty || cony || cor | 20| 3+ Sve comparison 4, Save sample list e

(] *  Name Control SampielDs
R EE B ) D108vs D72 Show/Hde
[ = T SRR LR D108vs D8g (e
= Heovw Show/Hde
——— 2. Check genes of interests | ocn 0i0s.072 ———
Eam (- w oA Protein_ D108 D84 Show/MHde
EFPRMHEOYRERRE = Compartson_Protein_D108_096 Show/Hide Show/Hde
Shawing 110 6 of 6 entries. Provicus 3| Nest
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To view selected genes or comparison, click “My Results” link on the left menu and then “Gene Lists”.

M CHOmicS (v1)  Toolbox™ My Analyses > Admin~ Prajects (1) Companscns 02)  Samples Gl
» import Progect Data

Search

R Py

» Gone Expression Plot

Q Acvanced Sear R a a » Reset soarch conditions

» Correlation Tool

Check/Uncheck Al

» PCA Analysis
» Export Expression Data os
0 Comparnon-based Anatyss - Name
» Volcano Piot
1 1 Sopue Di08vs072
8 40 4 »Sgnificantly Changed Genes D108vs.084
» Pathway Heatmap
Moy D108vs. 096
» Export Comparison Data
=ZRRWE Comparison_Proton. 0108072
Patrvaary Viesalzation
=M Comparison. Proten. D108 084

» KEGG Pathwiy View
» Reactome Pathway View Comparison_Protoin_0108_0g6

» WiPathasry View
Showing 1t0 6 of 6 of

Ontr Toots

» My Saved Lists
» Functional Envichment 1 Click to switch to different saved lists
» Overlap and Veenn Diagrams.

» Search Functional Gene Lists
» Compare Gene Lists
» Mota Analysis

» Manage Platforms

4% CHOmics (vl) Toolbox~ MyAnalyses~ Admin~ Projects ) Comparisons (12)  Samples (300 Hello, Demo User  (# Sign Out
My Saved Lists List category
Catogory: (Al s » ved Uets | Croate now st
Cotmnvisbtty || Copy | | cov | Show( 100 8lentries search [
Name ~| category Count Time
bubble_demo n Comparison 6 2020-02-25
bubblo_demo n Gene 15 2020-02-25
DEGs_D108va D72 n _ Gene 189 2019-10-24
Gones_allcompare n Gene 9 2020-01-14
RNA and Proteomics n Sample 20 2019-11-03

Showing 110 § of § ontries

One additional way to select and save genes or comparisons is from the ‘significant changed genes’ in
toolbox. Using the dynamic filters to choose the comparisons or genes you are interested in, and you
can use the table at the bottom to save comparisons or genes.

SRS % CHomics V1) Toobox =/ N Arsiyese =7 A I\ Ciects 0 0P "“{ 2. load comparisons from prolect]

»import roject Data

??amh Significantly Changed Genes

—a—

BCruoComparson st @Crestoasamplatist > -« Comparisons: Load from sived lists @ Search and Select Q@ Select a Proyect X Cle

1. click significantly changed genes]

Dioe084 [ 3. Filter genes ]
D108v.006 Or. upload your comparison Sles: Choose File | No file chosen

Comparson.Proton. 0108.072

e ODisplay Options: 8 Log2FC @ PValuo @ FOR /

Compurison Protein. 0108096 Fold Change Cuteft. 2 ¢ BothUp-and( :

Statistic Cuto# ~ FDR ¢ S | oos o
List Genes: @ Common Genes from AlLC Genes from Ay Compar
PR & it Over

» Mansge Platiorms
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es 2 4. Save comparison list ]

* Gene Expression Plot » Heatrmap » Commlation Tool » PCA Aralysis » Export Exprossion Dats

Copy

Colmn visdity

6. Save gene list ]

Showing 110 10 of 40 entries

Search 1

Description LogzFC PValue FOR LogaFC Pvaiue FOR LogaFC ~ PValue -FOR
N\

5. Selectgenes J 10525 00008 13996 00001 13009 00022

14122 00000 16577 00000 15824 00000

Rho guanine nuclectide exchange factor IGEF) 37 12755 00024 13097 00002 -16g78 00002

Calcr calcitonin receptor 13005 o007 19313 00001 2805 00000
calpain 8 11739 00088 14216 ooot 11208

cadherin 17 21087 26875 00009 /a2 00006

Cdiknisc cyclin-dependent kinase inhibitor 1C (P57) 11140 00051 15053 00005 14709 00010
CUGEP. Elav-Uke famity member 5 14453 14787 11800

Chad chondroadherin 12709 00067 17458 00003 17059 00024

Crispidi2 cysteine-rich secretory protein LCCL domain containing 2 18240 13480 19423 00087

Showing 110 10 of 40 entries

cotorschome: NN

) orc-o N [EREY

3.4 Advanced Analysis
Besides the above analyses, the CHOmics also provides several advanced tools.

3.3.1 Correlation Tools

Once the user has identified a gene of interest, the user can use correlation tools to find other genes
that share similar (or opposite) profiles in terms of gene expression or fold change. First, enter the gene
of interest, and samples to be used for correlation. In the example below, we entered a saved gene list,

and 15 samples.

A CHOmICS 1) Toome = o 1% ST (4
Correlation Tool

3. Enter or load

2. Enter gene of

. saved samples
interests P

Advanced Opl 5 .
sdsssiokied 4. Set options

om0 o 13 2mcarm o e
a1 comeianonn s0ernl ol seadatie gmes @ Sulabie ¥ CHEANS IS ELISEAS WWEng T STIred ors oty

Conetates

* Poarson Commacon ) SoaarTTen Comuanon Peeron Comeunon Coefiont eteeen Rawed Varutwes

Eratle Log, Transtor

i The result shows a table of correlated genes, ranked by R? ]
Matched Cane Cormelation Cost .

oo | Sow 100§ emnes

fote Do Lo 19 550 O

Souce Gene A Sousre. # o4 Outa Pt rerem
cosr e s CL
om0 oome ¥ e
B o0us oo g w
oma ogan 2o
o8 oumy E LT
09504 o9 x e
oosm oww 5 o
ousr suns e
09808 owm s
one ™ . e
ooses owrrr s CL
oo sane e
208w oww » e
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Click the plot icon will show scatter plot of the target and the correlated gene (e.g, gene Grn vs. Ctsa).

Pearson Correlation: Grn vs. Ctsa x

1250
1000
E
o
750
Siope Int Cor
500 Gm vs Ctsa 231 -6.34e+1 9.97e-1
210 280 350 420 490 560 630

Gm

Correlation: 0.9967 R_Square: 0.9934 Linear Regression: y - 2.3077x * -63.3839 # of Data Point: 15

3.3.2 PCA Analysis

You can select a set of samples and genes and use PCA plot to visualize the sample relationships on the
target gene set.

4 CHOmics (v1) Toolbax> My Analyses > Admer= Projects i2) Compansons (360 Samplos (85

PCA Analysis

1. Enter or load 2. Enter or load

gene of interests saved samples

Samples  » Load fn ) Q Search and Sols Q Setect et X

3. Select sample attributes
for visualization

Sample Altrioutes: (3

Age Colllype ~ Collection  DiseaseCategory — DweaseState ~ Ethnicity  FlagRemark — FlagToRemove  Gender Infection — Organism RINNumber  RINAS Rate  RNASeq RNASeq Total Rssd Count
Response  SamploPathology  SampicSource | SampleTypo | SamplngTme ~Symptom @ Tmswo  ThsuoCategory  Transfoction @ Treatment UberoniD  UboronTerm w7 Check Al X Chieck N

The system will use FactorMineR package to run PCA analysis and display the results. Several PCA
metrics are plotted for interactive visualization:

Eigenvalues plot the percentage of variance explained by top PCs.
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Variables Plot shows the weights of top contributing genes in each PCs.

Variable Data summarizes the weights of each gene in each individual PC.

Individuals Plot shows the relationship of samples on the spanned space by different PCs.

Individual Data summarizes the score vector of each sample in each individual PC.

A CHOmics (vi) Toolbox~¥ MyAnalyses~ Admin~ Projects(2) Comparisons (16) Samples (56)

FactoMineR PCA Analysis

» Genes & Samples Analysis #» Saved Results *» PCA tool for uploaded data files

[SCLIEITEREY Variables Plot Variables Data | Individuals Plot Individuals Data | B Save Results
Q

Bar Chart

Percentage of Variance

" ..------— po— 0.684126

PCI PC2 PC3 PC4 PCS5 PC6 PC7?7 PC8 PCY9 PCI0 PC11 PClZ PCD@

D.mensmns
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4 CHOmics (v1) Toolbox~ MyAnalyses> Admin~ Projects (2) Comparisons (18) Samples (58)

FactoMineR PCA Analysis g Upload own data for PCA analysis ]

» Genes & Samples Analysis » Saved Results l":'ﬂ'u,ﬂ for uploaded data files |

| Eigonvalues | Variables Plot | Variables Data [REGIMETECSSE individuals Data | B Save Re

w in Full Sereen
Parameters
X Coordinate:
PC1(64.38%) Treatment
1(64.38%) :
6 H o
Y Coordinate a8
PC2(763%) s 4 M oow
Color By: Troatment
Treatment ; 2 i
+ om
Shape By: L
ET . . -
reatment ¢ § o DTBADIO s m s b
2 L]
Size By. e DK1B20108
T o
(None) : &_) 2 nxmv‘m:
Label Sizer 11 px @ Show Labels DK183072 K
& '
—_— -4 i i
L‘-Di"” DK1B3D108
Marker Size: 71 px °
e B — 5 ! DK1B1D108
°
Graph Size: 710 " 532 px
S, S 8 '
'
-20 -15 -10 -5 [} S 10 15

PC1 (64.38%)

Graphic options. You can use attributes to define sample color or shapes. ]

The PCA results can be saved. Users can load it in the future.

My PCA Saved Results
Title Description Actions.

Users can upload their own data matrix or pre-calculated data for PCA analysis and visualization.

PCA Scatter Plot Tool

» Genes & Samples Analysis » Saved R ts » PCA tool for u;

Upload Files: Data file

Data File: Choose File No file chosen » Example Data File
[ Data matrix for PCA ﬁml% File: Choose File No file chosen » Example Attributes File

Variance File: Choose File No file chosen » Example Variance File

5 required

Format: Ocsv  tt/tsv

3.3.3 Meta-Analysis

Meta-Analysis can be used to identify genes that are changed consistently across multiple projects. It is
listed as one functional module in toolbox panel. In the example below, we are looking for the most
significant DEGs in three comparisons.
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% CHOmics (v1)  Toolbox~ MyAnalyses~ Admin+ Proiects ()

Meta Analysis Enter or load comparison list
R i Save meta-analysis results
Genos._ » Load from saved lists  Q f jor X Cle » Q in *

Enter or load gene list

Attributes to show in results table ]
Gene Attributes: (3 selected) » Show Attribut

GeneName @ EntreziD Source @ Description Alias Ensembl Unigene Uniprot TranscriptNumber Strand Chromosome Start End ExonLength AccNum v A X Chock None
Advanced Settings » Togae

Missing data atiowed for P-value: 03

LogaFC cutoff ( Is 2 fol! A Optional parameter setting for cutoff

Statistical type for changed gene: R e on meta-analysis statistical results

Statistical cutoff:

The meta-analysis pipeline will compute three types of results:

1) Maximum p-value (maxP). This method targets on DEGs have small p-values in "all"
comparisons. We recommend using maxP if you are looking for DEGs that are common among
several studies.

2) Fisher’s p-value. The Fisher’s method sums up the log-transformed p-values obtained from
individual studies. This p-value combination method is useful if you want to identify DEGs in any
of the comparisons.

3) We also applied simple counting method to report the frequency a gene is classified as up or
down-regulated DEG from all the comparisons. The default DEG cutoff is two-fold change and
FDR<0.05. but user can change the cutoff.

In most cases, combing maxP (smaller values are more significant) and the counting method (e.g. up-
regulated in 50% of studies) will give the most biological relevant results for consistently regulated
genes across comparisons.

Meta Analysis Result » Create New Meta Analysis %Optional tools for visualizing and saving results]
DR D PSS, :|J Filtering A Columns in results table ]

Toggle columns: ¢ GeneName # EntreziD Description Genelndex Ndata points

¢ UpPer Down Per ¥ RankProd ¥ RP_logFC ¢ RP_Pval ¥ RP_FDR

¥ Combined_Pval_Fisher ¢ Combined_Pval_maxP ¥ Combined_FDR_Fisher ¥ Combined_FDR_maxP DBavsD72.logFC D84vsD72_Pval
D84vs.D72_FDR Dgbvs D84.logFC Do6vs D84 Pval DgbvsD84.FDR D108vs Dgé.logFC D108vs.Dgb_Pval
D108vs Dg6_FOR

Columnvisbity | Copy | csv Show 25 3 entries search |
GeneName EntreziD UpPer RankProd RP_logFC RP_Pval RP_FDR *  Combined_Pval_Fisher Combined_Pval_maxP Combined_FDR_Fisher Combined_FDR_maxP
Mb21di 214763 666667 87760 00000 00000
Snordise 100302504 333333 79260 10500 00000 0.0000
Hspaia 193740 333333 157900 0.0002 00004
LOC10068g269| 100689269 333333 149500 00000 0.0000
LOC100689270 | 100689270 333333 139000 00000 00000
Caler 12311 333333 360400 0.0000 0.0000
LOC113832837 | 113832837 333333 338000 00001 00000

S——
Showing 110 7 of 7 entries . e e . Prov 1
Select genes for visualization and other analysis ]
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In the above example, we used a relatively loose filtering criterion (N.data.points>1, and up-regulation
in percentage>30% of studies, and Combined_Pval_MaxP <=0.0001) because only small number of
genes pass the stringent default criterion.

Display Options x

¢ Ndatapoints>= 1

¥ Percentage Up-Regulated >= 30
Percentage Down-Regulated >« 0.01

¥ Combined_Pval_MaxP Cutoff <= 0.0001
RP_Pval<= 001

Pval Fisher Cutoff<= 0.01

Number of records to show: ® 100 1000 3000 (limit)

Y Update Settings eIt

The data table shows the genes that pass the filters. We can sort the table by maxP value. A different
filter can be applied to get down-regulated genes.

The results can be saved for future access. There are also links to several other tools. The download
meta data link will save a CSV file that contain results from all genes.

Next, we will choose all the genes that pass filter by checking the box for all listed genes, and use bubble
plot to visualize the results.

Bubble Plot Multiple

Genes: » m saved Q e s X i Comparisons:  » Load fron od lists Q \and t  QSeioct t X

. i Selected gene list ] <[ Comparison list for meta-analysis ]

o

Chart Height Scale Factor:

Chart Left Margin Scale Factor:

. 4[ Unclick p-value and FDR to show only logFC ]
Show Columns in Table:
¥ Log2FC P-Value [_FOR

The resulting bubble plot will show all three comparisons for each gene.
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% CHOmics (vi)  Toolbox~ Vs Admit v . r . v &z »

i Download data ]

Bubble Piot

Log 2 Foid Change
D108 vs D96 logFC D84 vs D72 logFC D96 vs D84 logFC
Columnvisbiry || Copy || csv |SPOWI 100 ¢ entr

4 Geneindax D108vs D90, logFC 084w D72 logFC D98ivaDe4_logFC

The data table below the bubble plot can also be used for filtering. Remember in the advanced settings,
we choose to display logFC only, this makes it easier to look for genes that are reverted in different time
points. The logFC values are colored coded (red, increase, blue, decrease), therefore we can see that
most of genes show upregulation in D84, and then downregulation in D96 and then upregulation in
D108.

You can also redo the plot, check all columns to include p-value and FDR in the table, and export the
results to excel file.

The workflow above uses up-regulated genes as example. You can get down-regulated genes from the
filter step in meta-analysis result page.

4 Visualization

4.1 Visualize Gene Expression
CHOmics provides tool to easily visualize gene expression level across multiple genes, samples and
omics. For each gene, you can view its expression levels across multiple samples.

4.1.1 View Gene Expression from multiple samples

Choose the Gene Expression tool from Toolbox -> Gene Expression Plot from top menu, and enter the
official symbol of genes or load gene list from saved lists. Alternatively, in the gene details page, click
View Gene Expression link.
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# CHOmics tva) T by
Gene Expression Plot Gene Expression Tool ]

Gones: » vod lists  Q Load f x Samplos % Load < Q ' Q

;[ 1.Enter or load gene symbol or list ] /[ 2. Enter or load sample list ]
Platform Type:  RNA-Seq Oniy,igniore Mcroarray Samplos. ~ Microwrmay Ordy,ignore RNA-Soq Samples @ Automstic based on the entered samples <[ 3. Select data platform and type ]

DataType  Publiconly ~ Privato only @ Automatic based on the entered sampies

x

Sample Attributes: (3 selected)  » Show Al -

4. (Optional) Choose attributes, apply data filters ]

RINNumber | RNASeq Assgnmont Rato |~ RNASeq Mapping Rato  RNASeq Total Road Court. |~ Response  SamplePathology — SamploType

As an optional step, you can choose what sample attributes to pass to the plot, and use data filter to

choose only a subset of data points.

The Data Filter can be very useful if there are too many data points, and you want to focus on a few

diseases or tissue types.

The screenshots below show default boxplot showing all samples by different time points (i.e,

treatment).
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Summary of Data

« 169 genes found,
« 15 samples found: DK1B10108, DK1B20108. DK1B30108. DK1B4D108. DK1B1D72. DK1B2D72. DK1B3072. DK1B1084, DK1B2D84, DK183084, DK1B4D84. DK1B1Dg6. DK1B2Dg6, DK183096, DK1B4Dg6

Download: & Raw Data File

Log2(FPKM + 0.5)

foft Aot st atesalatelatinn:

l

i

ipbefstedontt

i

iﬁiii

iz

R

§
iltid

f

Customize Gene Expression Plot

The boxplot is created using CanvasXpress ( https://canvasxpress.org )plug-in, and sample grouping and
coloring can be customized by the user. In the example below, we show how data points are colored.

Summary of Data

« 169 genes found
« 15 samples found: DK1B1D108. DK1B820108. DK183D108. DK1B4D108, DK1B1D72, DK1B2D72, DK1B3D72, DK181D84. DK1B2D84. DK1B3D84. DK1B4D84, DK1B1Dg6, DK1B2Dg6, DK1B3Dg6, DK1B4Dg6

Download: & Raw Data File

Log2(FPKM + 0.5)

&
°

Troasment

@ oe
@on
@ o0&
Qo

[ 1. Right click on the plot to show menu ]

1o isetigtatesal

igf

Lelstolopiaili

ig

2. Group samples by treatment

Page | 31



4.1.2 View Gene Expression in Heatmap

Heatmap can be useful to visualize gene profiles from multiple samples. It can also provide information
about how genes and samples cluster.

8 CHOmICS (V1)  Toolbox ™ My Anatyses = Admn ™ Progcts G npactsons BB S Voo, Domo User (9 Sign Ot
Heatmap

Gones » Qoadf x Samgles: » 5 Q g Q seiocta Project X

the % 2. Enter or Load Saved Genes ]

J 4. (Optional) Choose attributes overlaying on heatmap ]

Flag ToRomove  Gondior

RNASoq Total Read Count

TesweCategory

‘ml 5. (Optional) Change data transformation, clustering options ]

You can enter genes and samples in the box, or load pre-saved genes and samples quickly from your
collection. Be default, we will log2 transform the gene expression data, perform scaling of the data
across samples for each gene, and limit the scaled value to -3 to 3 before displaying the data in
heatmap. This works well in most situations. However, advanced users can change the options. For
example, if you want to keep the order of samples as you entered, just uncheck “Cluster Samples”.

Advanced Options %

Data Options
Enable Log2 Transform
Value To Be Added For Log Transformation: 0.5
@ Enable Z-Score Transform
Enable Upper Limit 3
Enable Lower Limit -3

Cluster Genes
Cluster Samples

Display Options
Overlay Samples
Display Gene Names
Display Sample IDs

The heatmap is rendered by CanvassXpress. You can change the plot size if needed.
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Download: & Raw Data File & Heatmap Data File l Bookmark URL

Gene Expression Levels
Z-Score from log2(FPKM + 0.5)

I 0 l

AE

| I||‘| wil e b

i

| |
— DK1B4D108 1 I | I |
 DK1B2D108 ‘ |

DK1B1D108

[ DK1B3D108

— DK1B1D96

In the example heatmap, we entered a few significantly differential expressed genes between time D72
vs time D108. From heatmap clustering, we can see that the samples are clearly clustered by time points
with increase of expression on most of genes along with time.

4.1.3 Multi-omics Expression View
Besides the plotting of transcriptomics data, CHOmics also enables the visualization of other types of
omics data such as proteomics, and the comparison across omics.

Here is an example of comparing gene expression (transcriptomics) and protein expression (proteomics)
of gene CTSA at different time points, using the ‘Gene Expression Plot’ tool. By righ clicking the plotting
area, users can group the samples by different treatment time points while segregating the data by
omics type(i.e, Samplesource).
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4 CHOmics (vi) Toolbox~ My Analyses> Admin~ Projects(2) Comparisons 18) Samples (56)

€ Plot

& Reset All

Summary of Data

* 1gene found Ctsa
= 25 samples found DK1B10108, DK1B2D108. DK183D108. DK1840108, DK1B1D72. DK182072. DK183D72. DK1B1084, DK182084, DK183D84, DK184D84, DK181Dg6, DK182Dg6. DK183096, DK1B4Dg6, P_DK1-B1-D108,

P_DK1-B2-D108. P_DK1-B3-D108. P_DK1-84-D108, P_DK1-83-D72. P_DK1-B3-D84, P_DK1-B4-D84. P_DK1-B2-Dg6, P_DK1-B3-Dg6, P_DK1-B4-Dg6

Download: & Raw Data File

Log2(TPM + 0.5) of Ctsa

. we

s v

0

Transcriptomics

Proteomics

on

D108

on2

L Fie

-« Explore

B Daa

%3 Data Point Attributes

Wi, Group Samples
4} Segregate Data

> v v v v v w

@ Poteomcs
@ Trcrsionc

4.2

Visualize Comparison Data

4.2.1 Dashboard View of Comparison

The dashboard shows a summary of all the comparisons.

1]

Hello. Demo User @ Sign Out
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Mot e Uher 99 5 Ot

PHCHOMICS VD) Tookam™ My Artyses = Ao ™ Pragmets 31 Cormparnons i Semies

O All Comparisons [y

e Display Options

Serty # Courts O Apratees

Comparnen )

Comparison Category Setecied 1 out of 100 © e C Dioasce S2ate atactod 16 0t of 19 O Fow

Click to select
Treated vs. Control

Ttract Sabecied 16 0t of on Puttrm Narme Catecte 36t of 33 O

Platforms used to
generate data for

these diseases

The above dashboard shows the comparisons from different Categories, Cell Type, Disease State,
Treatment, Platform, etc. Below the dashboard, there is also a table listing all the comparisons.

In addition, users can set Dashboard Preference to change how the comparison summary is displayed.

Dashboard Options

Comparison Category:
¥ Show Top 15 Only
Cell Tissue:
Hide "Unknown Tissue® Hide "Others’ Type [ Show Top 15 Only
Disease State:
Hide *Unknown Disease” Hide ‘normal control® [} Hide ‘Others’ Type [ Show Top 15 Only
Treatment:
Hide "Unknown Treatment® [} Hide "Others’ Type Show Top 15 Only
Platform Name:

Hide "Generic’ Types Show Top 15 Only
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4.2.2 Bubble Plot
Bubble plot is another useful demonstration of gene or gene set in comparisons. For each gene, you can
view all the available comparisons in a bubble chart.

4 CHOmics (v1) Toolbox ~ MiAnalysesv Admin ~ Projects (1) Comparisons (12) Samples (30)

Bubble Plot
» Multiple genes vs. multiple comparisons

Gene Name: Tgma
Please enter the gene name, e.g., BRWD1-IT2
Y-axis Field: Case_Treatment PN
Coloring Field: Case_SampleSource :

Comparison Type:

“»

All Comparisons

> Next Step

The default settings work for most users. After clicking the Next Step button, you will see a plot like:

OF Moddfy
Settings

The plot contans 12 out of 12 data points.

Bubble Chart for Tgm2
Colored by Case_SampleSource

@ Transcriptomics

D96 vs DB4 Proteomics

Disease_Sam

Disease_Trea plesource

096 vs D72 .
tment

084 vs D72 .

D108 vs D96 Q

D108 vs D84 .

D108 vs D72 .

0 0.5 1 1.5

Log 2 Fold Change
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In the bubble plot, the X-axis shows log2 Fold Change of the comparison, the Y-axis shows
‘Case_treatment’. Each dot represents the comparison result of this gene from one comparison. The
color of the dot represent ‘Case_Samplesource’ (i.e, here we set as omics type), and the size of the dot
represent significance (-log10(FDR), larger is more significant).

The user can click and unclick the color legend at right to select or deselect omics types. When mouse
over a dot, more details are shown. And the user can also click the dot to link to other graphs.

The tool bars at top right corner allows the user to zoom and pan the graph.

The screenshot below shows the same bubble chart after selecting one omics type (i.e,transcriptomics),
and zoom into a portion of the chart.

The plot contains 12 out of 12 data points.

Bubble Chart for Tgm2
Colored by Case_SampleSource

Select omics to show in Proksalce
bubble plot

D96 vs D72

Move over mouse to

click to see comparison
detail

0108 vs 096

D108 vs D84

Log 2 Fold Change
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Data Filter and Advanced Settings in Bubble Plot

In addition, advanced users can change settings by click "Modify Settings Button". For example, the user
may want to show a selected list of diseases. After clicking Customize in Case_Treatment, user can select

which treatments to display in the pop-up window.

P-Value ® Adjusted P-Value

Y-axis Sett Case_Treatment /V
Show Top 10 © Show Top 20 © Show All{® Customize
Coloring t Case_SampleSource
Show Top 10 ® Show Top 20 © Show All © Customize
S Kocky The plot contains 12 out of 12 data points.
Settings
& Download SVG

After modifying the setting, the user can click
plot button to view the new chart. The system will display
how many data points are chosen based on the filter.

The plot contains 6 out of 12 data ponts.
Sottrgs

Bubble Chart for Tgm2
Colored by Case_SampleSource

oot w072 ®

12

Log 2 Fold Change

Treatment'*

Chack / Uncheck Al

Dgévs D72
D108 vs 072
Dgbvs D84
0108 vs D8

D108 vs Dg6

Occurence
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Bubble Plot of Multiple Genes and Multiple Comparisons

It can be useful to look at a set of genes (e.g. all differentially expressed genes, or genes from a certain
pathways) in a set of related comparisons (e.g. all from the same disease).

To view this type of bubble plot, select the link for Multiple Genes vs. multiple comparisons.

@ CHOmics (v1) Toolbox~ MyAnalyses~ Admin~ Projects(2) Comparisons 16) Samples (56)

» Multiple genes vs. multiple comparisons
Bubble plot of gene set ] Gene Name
JaI-<3|
Please enter the gene name, e.g., BRWD1-IT2
V.avic Eiold
Y-axis Field Case_DiseaseState ¢
Coloring Field
Coloring Fielc Case_SampleSource B
Comparison Type All Comparisons 8
> Next Step

In the Genes and Comparisons Bubble plot window, you can now enter the symbols of the genes, and
the comparison names. However, it is much easier to use the saved genes and saved comparisons
features, or other tools from the system to quickly get a get set. Please see below for details.

A CHOmics (v1) Toolbox~ My Anslyses = Admin = octs 16)  Samples (56) 0, Demo Use @ Sign Out
Bubble Plot Multiple

»

Genes: » i v Q A s X Comparisons: » f ) ts Q Q ) < % Cle

ﬁLoad saved gene list ] ﬁLoad saved comparisons ]

o

In the example below, we use dashboard to select 6 comparisons that are for different time points in
CHO cell lines. We save the comparisons and load in the bubble plot tool. For gene list, we get the up-
regulated genes from comparison D72 vs D108, and paste into the gene names fields.
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In the bubble plot, the gene symbols are listed in Y-axis. The X-axis represents logFC, and color of the
bubble represents comparison; the size of the bubble represents the significance.

4 CHOmics (v1) Toolbox~ MyAnalyses~ Admin~ Projects(2) Comparisons (16) Samples (56) Hello, Demo User & Sign Out
Bubble Plot Multiple

» Single Gene Plot

Genes: » Load from save

sts Q Load functional gene sets X Clear Comparisons:  » Load from saved lists Q Search and Select Q Selecta Project X

Clear
Adamts6

Adamts7 D84vs D72
Adh1 DgbvsD72 ) ) ) )

Aebpi Up-regulated genes from D108 vs D72 Dio8vaD7 6 comparisons from different time points
Aff2 Dg6vs.D84
Ampd3 D108vsD84
e D108vs D96

Note: You must enter one or more gene names.

Note: You must ente

one or more comparison names.

Jle Advanced Settings

ﬁSubmit for bubble plot ]

Number of genes appeared: 169, Number of comparisons appeared: 6. » Download Data

C} -

Bubble Plot
Q D84.vs.D72

D96.vs.D72
ZfpS60
wnt8b

@® 0D108.vs.D72
@® D96.vs.D84
@® D108.vs.084
@® 0108.vs.096

Vcaml
Trim10
Tmem8b
Tmésf2
Sppl
Spata2s .
Slc9b2
Slc6as8
Serpinel
Semada ®
Selplg

Scnda

-2 -1

Log 2 Fold Change

In the legend, the color keys for comparisons are shown. You can click the color key in the legend to
hide/show comparisons. The size of the color dot in the legend correlates to the largest bubble for that
comparison, which is the most significant gene with the smallest FDR.

Bubble Plot of Multiple Omics data

Similar to the bubble plot of multiple genes across multiple comparisons, users can further compare the
genes on the comparisons from different omics data.
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Bubble Plot Multiple

» Single Gene Plot

Genes »loadfromsavedliste Q Load functiona X Clear
cdki
cltc
crip2
gmg242
hadhb
khsrp
. 1 X
ad Settings
Number of genes appeared: 10, Number of comparisons appearad. 2. » Doynlog
Tgm2
Tagin2
sfoa @
!
Lres9
Khsrp {‘%
Hadhb od
o,
Gm9242 @
Crip2 =
Cite
Cdk1 @
-15 -1

[Comparisons from multi-omics ]

Bubble

0.5

Log 2 Fold Change

4.2.3 Getsignificant genes from comparisons
Another way to get a gene set to visualize in the genes/comparisons bubble plot is to filter for
significantly changed genes. To do this, first select a few comparisons from the dash board, and click the

"View Significantly Changed Genes" button.

# CHOmMICS (Vi)  Toolbax~ My Anstyses = Admin Proects (1) Compansons (13} Samoles Lol

& My Private Projects

» Lload fromsaved lists. Q Search and Selecl Q Select s Pr _J.I/

Comparison_Protein_D108_D72

D108vsD72

B Q4 ogEX# >
Plot

@ 0:108v:.072
® Comparison_Protein_D108_D72

o0
@

@

Hofio, Demo User  § Sgn Out

Qsow
© All Comparisons X | c... . p: OSow
Significant changed genes
= >
= List of Comparisons B
Sowen
PlatformNarme
. 20 “ Cehers Urknown Tasue Unbnown Oseose Doh vs D84 Ganeric Mouse NGS Platform
. Dgbw 072 Onhers. Urinown Tasue Uninown Disosse Dg8ws D72 Ganenc Mouse NGS Platiorm
. D8sv ” Others. Others Othars. Désws D72 Canenc Mouse NGS Platiorm
. Cenors Uninown Teswe Uniroran Dsoaso 0208 vs DoS Ganenc Mouse NGS Platiorm
v 08 vu D8y Ohors. Uninown Tasue Unknown Disoase D308 vs D84 Geneonc Mouse NGS Platiorm
“ nodvs D72 Ceners. Urienown Tasuo Unknown Osease 01083 072 Ganeric Mouse NGS Platlorm
son_ Protesn, Do, D8y Troated vs Cortrol Crhers. Otrers Dot vs D8 Generic Mouse NGS Platform
Troated vs Cortrol Others. Others Db vs D2 Generic Mouse NGS Platiorm
Treated vs Cortrol Cthers. Others Dlsvs O72 Ganenc Mouse NGS Pltform
0. 00 Troated vs Cortrol Oehors. Others. D308 vs Dgb Ganenc Mouse NGS Pltform
Srowng 11010 of 32 entres 1|2 New

Dashboard filter.
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In table, select comparisons and view significantly changed genes.

In the significantly Changed Genes window, the comparisons from the previous page are already loaded.
You can add or remove comparisons if needed.

Now select direction (up-, down-, or both), and use the logFC cutoff and FDR value to get a list of genes.
Depending on the comparisons, sometimes you may need to adjust the logFC and FDR values to get a
good list of genes. In general, for bubble plot, using <100 genes will make the graph easier to read.

Once you are happy with the gene list, you can save it. You can also export the list for later use.

4 CHOmics (v1) Toolbox~ MyAnalyses~ Admin~ Projects(l) Comparisons (12) Samples (30)

Significantly Changed Genes

Comparisons: » Load from saved lists Q Search and Select Q Select a Project X Clear

D108vs.D72
D108vs.D84
D108vs.Dg6
D84vs.D72
Dg6vs.D72
Dgb.vs.D84

List of selected comparisons

Or, upload your comparison files: Choose File No file chosen » Demo Data

Display Options: ¥ Log2FC ¥ PValue ¥ FDR

Fold Change Cutoff.  Enter Value : 1 Both Up- and Down-regulated :

Increase or decrease
Statistic Cutoff:  FDR $ < 005 $
threshold to select genes

List Genes: ® Common Genes from All Comparisons Genes from Any Comparisons

& Start Over

» Save Comparison List » Bubble Plot » Pathway Heatmap » Meta Analysis » Export Comparison Data » WikiPathways » Reactome Pathways » KEGG Pathways
» Save Gene List * Gene Expression Plot *» Correlation Tool » PCA Analysis * Export Expression Data

Column visibility Copy csy Show| 10§ entries

Showing 1 to 10 of 15 entries

D108vs D72 D108vs.D72 D108vs.D72 D108vs D84 D108vs.D84 D108vsD84 D108vs.Dg6

GeneName = Description - Log2FC - PValue -FDR - Log2FC - PValue -FDR - LogaFC
Cd68 CD68 antigen 15075 0. ( 0.0000 000 0.0001
Clu clusterin 18516 C ( 0.0000 12528 ) 0.0000
Ctsb cathepsin B 11143 C o 0.0000 00 0.0000
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View Significantly Changed Genes in Bubble Plot

Back to the bubble plot, you can load the saved comparisons and saved genes and view the plot.

Save to comparison list

xport Exprossion Data

searcn [

Save to gene list I I I
g D108wD72 | D1 Di08vsDgS = D108vsDg6 = DB4vsD72 = D84vsD72

v - PValue -FOR ~LogafC - PValue -FOR - LogaFC - PValue -FDR - LogafFC - Pvalue
£ Cdés CD&8 antigen 15075 0.0000 00001 ¢ 0.0061
b Clu clustern 18516 C C 00000 12528 ( 00000 [ 0.0003
’ Ctsb cathepsin B 11243 ( 00000 0.0000 0.0006
v Ctsl cathepsin L 11178 o 0.0000 d 00000 ” 000C 0.0008
A Doxi2 diamine oxidase- “15420 C 00000 -09831 00002 04705 18€ 05774
Like protein 2
* G granulin w007 00 0.0000 0 0 00001 0000 00049
@ | LOC100771976 11626 0.0000 0.00¢ 00002
£ LOC10m62429 12001 0000 0.0000 o 00002
@ | Mmpg matrix > 00000 00001
metallopeptidase
9
v Mmp3 matrix 14305 000 00000 £ o 00001
metallopeptidase
3
£ Nppb natriuretc 17812 X 0.0000 00C 00002 [ 1 00100
peptide type B
C plasminogen 10157 ( 00001 1 ] 00005

activator, tissuo

In the example below, it can be seen that most significant genes come from down-regulated direction
from the first four comparisons.

€ CHOmICS (V)  Toolbax™ My Anafyses = Admin= Projects (1) Companisons (121 Samples ) Hello, Domo User
Bubble Plot Multiple
» Singlo Geno Plot

Genes: % Load from saved lists QL Load functionsl gene sets X Clear

cass
Clu
b
ot
Daxi2

Load saved gene list

08 Toggie Advanced Settings

Numbor of genes sppeared 15 Number of compansons sppesred 6 % Download Data

) @ 2 - =
Bubble Plot
@ 0108.v.072
Sppl . © D108.va.D84
Serpinl | © 0108.v5.09%
Serpinel | ® 084vs.072
Pt | @ 096.vs.072
Nppd @ 09.vs.084
Mmp3 |
Hmp19
L0€103162429 |
LOC100771976

-
= )

§o88

Log 2 Fold Change
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4.2.4 Volcano Plot
Volcano plot is useful to view a top level summary of how many genes are significantly up- or down-
regulated in a comparison.

A CHOmics (v1)) Toolbgx~ MyAnalyses¥ Admin~ Projects(2) Comparisons (16) Samples (56)

2. Search to find
comparison

Volcano Plot

Comparison Name D108vs.D72

Please enter the comparison id, e.g.. GSE43696.GPL6480.test2

Y-axis Statistics. P-value @ FDR Cutoff: 0.05 $
Fold Change Cutoff: 2 $ 3. (Optional)
Change settings
Chart Name Volcano Chart
Show Gene Symbol: © Auto (based on cutoff) Customize

PRSPl Chart Width (px): 1000 Chart Height (px):: 800 » Add A New Chart

Fold Change Cutoff: 2, Log,(Fold Change Cutoff) 1000, FDR Cutoff; 0.05, -Log;o(FDR Cutoff): 1.301

= View comparison details = View comparison genes

Volcano Chart

Down-regulated

Up-regulated

genes ! 1 genes o
1 1 Sppl
: :
1 1
1 1
6 Agpl | i i . Mmp3 | Clu
1 1
\ | v Ctsb . Nepb . Mb21d1
5.5 LOC107979905 | I . ..Aebpl
1 1
DoxI2 1 1 ks
1 1+ iSerpinfi. 3 . Caler
’ ! 4 2 Nrp2 . 2fand2a
| AT Mmp9
| 1, L Fthl . Fn3
4.5 : : . Clqtnfs
' ..} Gpnmb DE30003M21Rik
4 AtfS : : . Sept3
& Arhgef37 i s g0 Cdsn . Rgs2 _ Gm2s710
8 ' o 'oc113834278 .
g 35 H Aace .. Rasal2
g 1 Loo B3l peghbs | A3 postn . Cdm7
T 1 b L3mbti4 "
3 Cdknlc ' o U""‘,‘ a2 e Hspala
Loc103162673 N80 . l-"'{;‘h""s " Hsd3be*, " C LOC113831153
Pacsinl 1 L Nr4a3 Dcn
- 1L0C107978467 1 f, od " Snord\ts
e . : : . Naaladi2, Gm6583 LOC113837147
LOC103160403 i 2 .
A 1, egyp2fzs AdMlchopiap  PIKS
2 . r $=cer gy
! Sk L %
CE St A B .
15 . et % g e .
o o S A "R AR T L | |} [ B -
ot ol,,
ol )
. i or
ol 1
1 .
0.5 1 1—
boe 1
1 &
0 1 1
-2.5 -2 -1.5 -1 -0.5 0 0.5 1 15 2 2.5 3 35
log2(Fold Change)
* up lated + down lated © unr lated =--d fold threshold = - upfold threshold ~ - significance threshold

Highcharts.com
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You can use mouse to drag over an area to zoom in.

Mouse over a point will show the gene details. Click the data point will show you links to other graphs.

View Multiple Volcano Plots Together

Users can also show multiple comparisons side-by-side. If needed, the user can also highlight the same
group of genes across the volcano plots.

4 CHOmics (v1) Toolbox~ MyAnalyses~ Admin~ Projects(2) Comparisons (16) Samples (56)

Volcano Plot

Comparison Name:

Y-axis Statistics
Fold Change Cutoff:

Chart Name

Comparison ID

» Remove Comp
Y-axis Statistics
Chart Name

Fold Change Cutoff:

Statistic Cutoff:

Show Gene Symbol:

D108vs.D72

Please enter the comparison id. e.g. GSE43696.GPL6480.test2

P-value @ FDR Cutoff: 0.05

2 s

Volcano Chart

D108vs.D84

-
<

Please enter the comparison id, e.g., GSE43696.GPL6480.test2

P-value @FDR
Volcano Chart
2 s

0.05 s

© Auto (based on cutoff) Customize

FORSTETTE Chart Width (px): | 1000

The first
comparison

The second
comparison

Chart Height (px): = 800

Use “Customize” to highlight
genes entered in the text box

[ Add more comparisons if needed ]

» Add A New Chart

The resulting volcano plots are shown as below. Selected genes are shown as orange dots.

Volcano Chart

| o0t
i — , wmaia
797995 v
'
oeiz '
' Caker
'
'
'
'
'
'
s
Avoets7 | H "2 Ce2eni0
'
' il
' [ A poatn cam?
' i
Canie H S . Wepaia
ey M . I ., T oy |
Pacyimi 4 e
LOCI07978467 | R -
Wy, bt} 1l wanone
' " Wepaia
1ocioneoes | oF i
v
i} LA
'
n
s i e e e e B e b e T
.
i
"
i
il
i
i
'
 wpregulated - down-regulsted - umegulated = downfold threshold = - upfold threshold = - wignificasce threshold

+ wp-regulated

- down-regulsted

Volcano Chart

unvegulited = - downlold theeshold = - uplold theeshold =  significance threshold
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4.3 Visualize functional pathway

4.3.1 Enrichment from Up and Down Regulated Genes

When you view details of a comparison, the functional enrichment results are shown. Briefly, for each
comparison, we generated the up- and down- regulate gene lists, and use these lists to compare with all
genes in the genome to identify functions that are significantly enriched.

MOOmes i) T - . e 00 -

D108vs.D72

o Pt Coerpry

1
t
i
£
§
i

OIS B ST 0 S ) T ) T T

U Sogpkatnd Garos " L&Opathwavs enriched ]
;[ Multiple pathway databases ]

§ | §

X

[ View full report ]

In the example above, this comparison is between D108 vs D72, and the top up-regulated biological
processed are response to virus, immune effector process.

Click the left menu will switch the bar charts for different categories (Gene Ontology, KEGG, Molecular
signature, Protein domain etc).

The bar charts here show the top 10 categories. To view complete results, click the Enrichment Report.
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Gene Ontology Enrichment Results |
ﬁ Download enrichment results file ]

Top10 pathways enriched ]

Enriched Categories
Togghe columas @ GO Tree @ TormiD @ Torm B Envichmeont @ ogP B Functional Terms Gonos @ Total Genes
2 cooy | | cov |SPow(10 §entres l/ Sewren |
GOTree - TorrmiD Term Eneichmaont 4 logP GenesinTerm ©  TargetGeossinTerm - Fractionof Targets inTerm - TotsiTarge Genes - TotalGenws ©  Actions
MSQDB  LEE.BMP2_TARGETS.DN LEE.BMP2_TARGETS.DN 3076324871508 700UH504200004 807 153 013871260100456 1303 15720
n
Gane GO 00&4424 intraceliular port 3363057990476350-  -503517766476754 13240 o3 076080108020802 212 20830
Ontology s
Gene GO0005622 intraceliular 6678872601715040-  -65 665670123744 7 L] oFraTIRTIRITIR ez 208%
Ontology £
Gene GO0005488 binding QAISBAAMONI00-  SEGMIGEIIG 12050 Baz 0758503401360544 176 20047
Ontologry s
Gene GO 0o0s730 nucieolus 5 G12061264420G40 5348504980028 813 s 010335 113631353 e 2080
Onology 24
Geno GO0GLse coll part 52816457 1786510 5120623839000 16460 w0y 0B54510661066306 w2 20830
Ontology 2
Geno CO0008623 ot 6308076000004000+  -BIIIMO0SEEIN 16465 03 0510601088308 w2 208
Ontology n
MSQDB  GSEE674 ANTIIGM.VS.CPG.STIM_BCELL.DN  GSEG574 ANTLIGM_VS_CPG_STIM_BCELL DN 1534864430036690-  ~470R58448500668 186 E 00507706265566364 no3 15720
n
MSGDE  KRIGE_RESPONSE.TO_TOSEDOSTAT 24HR_DN  KRIGERESPONSE.TO_TOSEDOSTAT 244R DN 1614456823888070-  -4767528838472909 865 140 01269265639:6501 103 16720
n
Gane GO 0043229 ntzacolular organedle 5011050343418620- -465773113685508 1500 829 0683003390339034 w2 208
Ontology an
Showing 10 30 of 1.001 entrics Pevious 12| 2 3 4 5 101 Next

In the enrichment report, the full list of functional terms are shown by order of p-value.

4.3.2 View Changed Genes from a Functional Term in Volcano Plot
From the bar chat, click a functional term, and you have the option to view these genes in a volcano

plot.

2.View selected pathway in volcano plot

1.Click to select a pathway to view

Once you click the link in the popup window, volcano plot will be generated for the comparison with the

changed genes from the selected term highlighted.
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4 CHOmics (v1) Toolbox~ MyAnalyses~ Admin~ Projects (1) Compansons 12} Samples (30

Volcano Plot Comparison of interest

O Back to Comparison Details
Comparison Name: D108vs D72

Please enter the comparison Id, e.g. GSE43696 GPLB4B0 test2

Y-axis Statistics P-value @ FOR  Cutofft 005 : Filtering genes from selected pathway ]
Fold Change Cutoff 2 3
Chart Name Volcano Chart
Show Gene Symbol: Auto (based on cutof) @ Customize

Genes: » Load from saved lists Q Load functional gene sets X Clear

Ctns
Ctsa
Ctsb
Ctsd

cdes
Clns Gene list to be shown ]

Chart Width (px) 1000 Chart Height (px). | 800 » Add A New Chart

Fold Change Cutoff 2, Loga{Fold Change Cutoff) 1.000. FDR Cutoff: 005, -Logi(FDR Cutoff} 1.301
£ View comparison details = View comparison genes

Volcano Chart

7 . .
] 1
! ! The changed genes from selected
6.5 . .
: t pathway are highlighted by colors
' '
6 . H ' .
1 1
I I ge Cisb
55 - ' 1 o« oo @9
1 1 “
Z | ' 3 "
) 1 . . .
s s cust .
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. ‘..8
) 1
45 1 1
| N
[ A 4
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g . 1
= 1
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]
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’ ' f
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.
o
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1
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-25 -2 -15 -1 -05 o 05 15 2 25 3 35
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4.3.3 View Enriched Pathways Directly from Comparison Details
From the bar chat, if you are viewing KEGG or wikipathway database, clicking the pathway name and
you have the option to view pathway plot.

3.Click to view the pathway

2.Click to select a pathway to view

1. select a pathway database to view

This will automatically open the pathway visualization page, and preload the pathway and comparison.
Click submit to view the pathway.

B CHOMICS (vl)  Toohow™ My Anstgms = Adirwe ¥ Pty [ Compasssn il Servpees (0 et Des \vee 9 50RO

KEGG Pathway View

0 o1
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Gene Set Enrichment from Ranked Genes

For each comparison, we produce a rank file for all genes using logFC. We use PAGE (Parametric Analysis
of Gene Set Enrichment) to identify significant biological changes. PAGE can be more sensitive for
comparisons where the logFC is relatively small, but most genes in a functional set show the same

direction of change.
The predefined gene sets were from MSigDB.

For each comparison, the top up-regulated and down-regulated gene sets are plotted.

Check gene set

PAGE Piot - Down-regulated Genes

Dot size represents ®
significance (FDR)

To view the full list of gene sets, you can click the report for genes as shown in following figure.

UP-Regulated PAGE Report  oeacx

# Gones. 2 Score PValue FOR

A_TETRASACCHARIDE. LINKER. SEQ

ACTIN_BASED.CEL

ACTIN. BINDING_GO

ACTIN, FILA

ACTION_POTENTIAL . GOBP. GO,

BINATION_OF IMMUNE RECEPTORS. BUILT. FROM. IMMUNOGLOBULIN. SUPERFAMLY . DOMAINS . GOBP_ GO.. 0002460

ADAPTIVE.IMMUNE_RESPONSE . BASED. ON. SOMATIC. RE

SPONSE, GOBP.GO. 0002250

4.3.4 Multi-layer visualization
If you are interested in a particular pathway, sometimes it is useful to map the RNA-Seq or microarray

data to the pathway for visualization.
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A CHOmics (v1) Toolbox~ MyAnalyses~ Admin~ Projects{t) Comparisons(12) Samples(30)

» Import Project Data

&2 My Expel .
y Gene Expression Analysis
Private Folder: Zopt/l * Gene Expression Plot iics.org/www.chomics.org/chomics/app.data/files._private/1000006_1kNmazZiNcodsw3JthDnGANHILGBK27jA1rxLpBCuDeU/
» Heatmap
o Create New Ex| 1 TPM (otherwise, in FPKM)
[ommiomtn | i
*» PCA Analysis
FExpor Expression Data s Abeieih it
2019-10-10 Comparison-based Analysis 2019-10-08
Samples (15) Samples (26)
» Volca
» Show/Hide Sarr o Pick » Show/Hide Samples
Analyses (1) *» Bubble Plot Analyses (1)
* Show/Hide Anal  gignificantly Changed Genes » Show/Hide Analyses

+ CHODemoR  » pathway Heatmap « Test1 (v Finished)

S Emort Compadson Biki 2. Select pathway for

visualization

Pathway Visualization

» KEGG Pathway View
» Reactome Pathway View
» WikiPathway View

& My Privat

Other Tools
» Functional Enrichment
* Overlap and Venn Diagrams
» Search Functional Gene Lists
» Compare Gene Lists

Created on 2019-1t
» Meta Analysis

CHO Demo -C

»Thereare 30sam Manage Platforms

» There are 12 comparisons in this project.

4 CHOmics (v1) Toolbox¥ MyAnalyses¥ Admin~ Projects(1) Comparisons (12) Samples (30)
KEGG Pathway View

& Start Over Note: * denotes required fields.

Glycolysis / Gluconeoge, \Wway File
/( 3. Choose pathway ]

» Select Pathway %

Comparisons:  » Load from saved lists Q Search and Select Q Select a Project X Clear

4. Choose comparison ]

D108vs.D72

Or, upload your comparison files: \ Choose File |No file chosen » Demo Data

Visualization:
5. (Optional) change
Gradient Blue-White-Red (-1,0,1) visualization settings

%G. Submit to view the pathway
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In the pathway plot, typically we use red-blue color scale to show the log2 Fold Change. Blue is down-

olor represents the significance

regulated, red is up-regulated. (c

of gene in the comparison
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Pathway Plot from Several Comparisons
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The user can add multiple comparisons from the pathway plot tool by clicking Add Comparison link.
Besides showing log2 Fold Change, the user can also show statistical significance by clicking Enable
Second Visualization Columns.

4 CHOmics (v1) Toolbox~ MyAnalyses¥ Admin~ Projects (1) Comparisons (12) Samples (30)

KEGG Pathway View

& Start Over Note: * denotes required fields

Glycolysis / Gluconeogenesis & Download Pathway File

» Select Pathway

Comparisons: » Load from saved lists Q Search and Select Q Select a Project X Clear

D84vs.D72
D108vs.D72 Choose multiple comparison

Or, upload your comparison files:| Choose File | No file chosen » Demo Data

Visualization:

Gradient Blue-White-Red (-1,0,1)

The pathway plot will now have multiple color bars corresponding to the different comparisons.
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4.3.5 Pathway Heatmap From Comparisons
Users can display the enriched pathways from several related comparisons, and visualize the top
enriched pathways across comparisons. Users can mix public data and inhouse comparisons.

4 CHOmics (v1) Toolbox~ MyAnalyses~ Admin~ Projects (1) Comparisons(12) Samples (30)
Pathway Heatmap [ Select pathway database ]
» Load from saved lists Q Search and Select Q Select a Project X Clear N
Select Sets: | KEGG E
H H Show Type: Top 10 @ Top 20 Top 50 Top 100
4{ Choose multiple comparisons ] The pathways are ranked by the w Ty,

most significant value

D108vs Do6

The heatmap shows pathways in rows, comparisons in columns. The statistical significance is color-
coded (log P-value, or Z-score). Pathways are sorted by the negative logP values from the highest to the

lowest.
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From the pathway heatmap, users can click any data point to view details.

Data Actions

» View Comparison Detail
» View Data in Volcano Plot
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5 Customized analysis pipeline

5.1 Use alternative tool or algorithm

The analysis pipeline is modular, each step can be modified by uses to use an alternative method if
desired. The users should be familiar with the Linux bash to run the analysis steps and be familiar with
php programming to make modification to the source code.

The full analysis pipeline has four steps, and each step is listed in a bash file in the analysis folder in the

system.

. step_0.sh FASTQC of raw data

. step_1.sh Alignment to genome

. step_2.sh Gene count

. step_3.sh DEG detection and functional enrichment

These bash files are created by PHP programs chomics/app/bxgenomics/bxgenomics_exe_analysis.php,
when users launch analysis pipeline online in a web browser via chomics/app/bxgenomics/analysis.php.
For example, the current pipeline uses subread to perform alignment. If users want to modify the
pipeline to change it to use the STAR program for alignment, they need the following steps:

1) Install STAR program on the server, prepare STAR index for the CHO genome.

2) Check the commands in step_1.sh, and change the commands as needed. In this case, the subread
command (subjunc step) needs to be replaced by the equivalent STAR command. Since STAR can sort
the bam files, the samtools sort step can be omitted. Finally, the STAR output file is named as
SamplelDAligned.sortedByCoord.out.bam, an extra step is needed to rename it to SamplelD.sorted.bam,
so step2.sh can output gene count files with the correct sample names.

3) Edit PHP program chomics/app/bxgenomics/bxgenomics_exe_analysis.php, find the part that
generates step_1.sh (The section is marked as “Step 1. Alignment with Subread”), and then make
changes accordingly.

4) Test the updated system to make sure it works as expected.
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